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Planning a BlackBerry Enterprise Server installation 1
You can install all BlackBerry® Enterprise Server components on one computer, or you can install specific components on
separate computers. Consider any impacts on system resources before you decide where to install a component.

Consider installing all components on one computer if you do not plan to activate many BlackBerry devices, if you have
determined that the computer can handle the traffic volume for the BlackBerry Enterprise Server components, or if you do
not mind that the computer has direct access to the wireless network. For performance information, see BlackBerry Enterprise
Server Performance Benchmarking.

Installing all BlackBerry Enterprise Server components on one computer

If you want to set up an evaluation or complete a simple installation of the BlackBerry® Enterprise Server for a small number
of users, you can install all the BlackBerry Enterprise Server components on the same computer.

During the installation process, you can choose to install all BlackBerry Enterprise Server components, including the
BlackBerry MDS Integration Service, on the same computer. The BlackBerry MDS Integration Service is only required if you
want to use enterprise applications on BlackBerry devices.

Installing the BlackBerry Attachment Service

The BlackBerry® Attachment Service converts supported attachments into a format that users can view on their
BlackBerry devices.

The BlackBerry Attachment Service might use increased system resources when it processes numerous conversion requests
at the same time. If you want to increase the number of conversion requests that can occur concurrently without impacting
message delivery, you can install the BlackBerry Attachment Service on a separate computer.

You can connect multiple instances of the BlackBerry® Enterprise Server to a single BlackBerry Attachment Service.

If you install the BlackBerry Attachment Service on a separate computer, you install the BlackBerry Attachment Service and
the BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Attachment Service and restarts it if it stops
responding.

Installing the BlackBerry Collaboration Service

The BlackBerry® Collaboration Service provides an encrypted connection between your organization's instant messaging
server and the enterprise instant messaging application on the BlackBerry device.

If you want to help maximize the number of available sockets so that the BlackBerry Collaboration Service can respond to
more requests, you can install the BlackBerry Collaboration Service by itself on a separate computer.
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If you install the BlackBerry Collaboration Service on a separate computer, you install the BlackBerry Collaboration
Service and the BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Collaboration Service and restarts
it if it stops responding.

You can connect multiple instances of the BlackBerry® Enterprise Server to a single BlackBerry Collaboration Service.

A different BlackBerry Collaboration Service exists for each instant messaging environment. For example, a BlackBerry
Collaboration Service exists for Windows® Messenger, and a different BlackBerry Collaboration Service exists for IBM®
Lotus® Sametime®. You can install only one BlackBerry Collaboration Service in your environment. Users can use only one
type of enterprise instant messaging application on their BlackBerry devices.

Installing the BlackBerry Manager

The BlackBerry® Manager allows administrators to manage a BlackBerry® Domain. A BlackBerry Domain consists of single
BlackBerry Configuration Database and all BlackBerry® Enterprise Server instances that use it.

You can install the BlackBerry Manager with other BlackBerry Enterprise Server components or by itself on administrator
computers. Install the BlackBerry Manager on administrator computers if you have many administrators or if administrators
cannot access the BlackBerry Enterprise Server computers.

Installing the BlackBerry MDS Connection Service

The BlackBerry® MDS Connection Service provides users with access to online content and applications on the corporate
intranet or the Internet.

The BlackBerry MDS Connection Service might use increased system resources when it processes content requests. If you
want to minimize the impact on message delivery, you can install the BlackBerry MDS Connection Service by itself on a
separate computer.

You can connect multiple instances of the BlackBerry® Enterprise Server to a single BlackBerry MDS Connection Service.

If you install the BlackBerry MDS Connection Service on a separate computer, you install the BlackBerry MDS Connection
Service and the BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry MDS Connection Service and
restarts it if it stops responding.

Installing the BlackBerry MDS Integration Service

The BlackBerry® MDS Integration Service provide connectivity between the BlackBerry MDS Runtime Application on
BlackBerry devices and enterprise applications.

The BlackBerry MDS Integration Service might use increased system resources when it processes content requests. If you
want to minimize the impact on message delivery, you can install the BlackBerry MDS Integration Service by itself on a
separate computer.
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You can connect multiple instances of the BlackBerry® Enterprise Server to a single BlackBerry MDS Integration Service.

If you install the BlackBerry MDS Integration Service on a separate computer, you install the BlackBerry MDS Integration
Service and the BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry MDS Integration Service and
restarts it if it stops responding.

The BlackBerry MDS Integration Service requires the BlackBerry MDS Application Repository, which the setup application
installs on your database server during the installation process. Each BlackBerry MDS Integration Service instance supports
one BlackBerry MDS Application Repository.

Installing the BlackBerry Router

The BlackBerry® Router connects to the wireless network and routes data to and from BlackBerry devices.

You can install the BlackBerry Router with other BlackBerry® Enterprise Server components or by itself on a separate
computer. Install the BlackBerry Router on a separate computer if you want to set it up in the DMZ, or to install several
standby instances of the BlackBerry Router as failover components in case your primary BlackBerry Router becomes
unavailable.

You can connect multiple instances of the BlackBerry® Enterprise Server to a single BlackBerry Router.

If you install the BlackBerry Router on a separate computer, you install the BlackBerry Router and the BlackBerry
Controller. The BlackBerry Controller monitors the BlackBerry Router and restarts it if it stops responding.

Installing the Hosted BlackBerry Enterprise Server

The Hosted BlackBerry® Enterprise Server allows you to make the BlackBerry® Enterprise Server available to other
organizations (for example, small or medium-sized businesses). When you configure the Hosted BlackBerry Enterprise
Server in your corporate environment, one or multiple organizations can subscribe to your service.

If you want to install the Hosted BlackBerry Enterprise Server, the installation process and requirements are identical to
those for the BlackBerry Enterprise Server. The Hosted BlackBerry Enterprise Server includes all of the components of the
BlackBerry Enterprise Server, but it uses a different licensing model.

Depending on how you configure your hosted environment, you might require additional configurations after the installation.
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System requirements 2
For information about calculating hardware requirements, visit www.blackberry.com/go/serverdocs to see the  BlackBerry
Enterprise Server Capacity Calculator and  BlackBerry Enterprise Server Performance Benchmarking.

System requirements: BlackBerry Enterprise Server

Item Requirement

operating system Any of the following operating systems:

• Microsoft® Windows® 2000 SP4 (Server edition or Advanced Server

edition)

• Microsoft® Windows Server® 2003 or later

• Microsoft Windows Server 2003 (64-bit)

• Microsoft® Windows® Small Business Server 2003 (Standard edition or

Premium edition)

messaging server Any of the following messaging servers installed physically close to where you

plan to install the BlackBerry® Enterprise Server:

• Microsoft® Exchange Version 5.5

• Microsoft Exchange 2000

• Microsoft Exchange 2003 or later

• Microsoft Exchange 2007

• Microsoft Exchange mixed environment (any combination of Microsoft

Exchange Version 5.5, Microsoft Exchange 2000, Microsoft Exchange

2003, and Microsoft Exchange 2007)

• Microsoft® Solution for Hosted Messaging and Collaboration version 3.5

messaging server system tools Any of the following messaging server system tools installed on the BlackBerry

Enterprise Server computer:

• Microsoft Exchange Version 5.5 Administrator

• Microsoft Exchange 2000 System Manager

• Microsoft Exchange 2003 System Manager

• Microsoft Exchange Server MAPI client and CDO 1.2.1

• to support Microsoft Exchange 2007, either Microsoft Exchange Server

MAPI client and CDO 1.2.1 or Microsoft Exchange 2003 SP2 System Tools

Installation Guide System requirements
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Item Requirement

Microsoft Exchange Organization of

the messaging server system tools

the same Microsoft Exchange Organization as the messaging server

version of the CDO library The latest version that is supported by the latest version of Microsoft

Exchange in your environment

Unicode support for calendars To support Microsoft Exchange 2003, the following Microsoft hotfixes installed:

• 913643 on your messaging server

• 923537 on the computer that hosts the BlackBerry Enterprise Server

Internet Service Manager To support Microsoft Exchange 2007, the Internet Service Manager component

of Microsoft® Internet Information Services

database management system Any of the following database management systems:

• MSDE 2000

• Microsoft® SQL Server™ 2000 SP4

• Microsoft SQL Server 2005 or later (Professional edition, Enterprise edition,

or Express edition)

• Microsoft SQL Server 2005 (64-bit)

collation setting To support Microsoft SQL Server, the following conditions on the database server:

• collation setting set to default case-insensitive

• BlackBerry Configuration Database collation setting set to default case-

insensitive

remote database conditions named pipes and TCP/IP network protocols turned on

data access components Any of the following data access components on the computers that host the

BlackBerry Enterprise Server or the BlackBerry Configuration Database:

• MDAC Version 2.8 with Security Patch MS04-003 (Version

2000.85.1025.00)

• MDAC Version 2.8.2 (Version 2000.86.1830.00), included with Microsoft

Windows Server 2003 SP1

database conditions for the BlackBerry

MDS Integration Service

A database server with the following conditions:

• host for the BlackBerry Configuration Database

• support for mixed-mode authentication

Microsoft® .NET Framework To support languages other than English, localized version of Microsoft .NET

Framework Version 1.1 SP1

instant messaging server Any of the following instant messaging servers:
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Item Requirement

• IBM® Lotus® Sametime® Version 3.0 Community Server

• IBM Lotus Sametime Version 3.1 Community Server

• IBM Lotus Sametime Version 6.5.1 Community Server (Version 6.5.1 or later

required to support dormant mode)

• IBM Lotus Sametime Version 7.0 Community Server

• IBM Lotus Sametime Version 7.5 Community Server

• Microsoft® Office Live Communications Server 2005 (SP1 is required to

support Microsoft® Office Communicator and dormant mode)

• Novell® GroupWise® Messenger server Version 1.0.2 or later

• Novell GroupWise Messenger server Version 2.0 or later

web browser Microsoft® Internet Explorer® with the following settings:

• Java® or JavaScript® turned on

• language preferences configured to display encoded web pages

media player To support audio attachments, Windows Media® Player Version 9 or later

network proximity A high-speed, switched connection between the BlackBerry Enterprise Server

and the messaging servers

firewall A firewall or proxy with the following conditions:

• support for the BlackBerry Enterprise Server to initiate an outgoing, two-

way TCP/IP connection to an external server on port 3101

• support for the resolution of Internet addresses using DNS

• transparency of the proxy server for proxy firewalls

System requirements: BlackBerry Attachment Service
The following system requirements apply when installing the BlackBerry® Attachment Service on a computer separate from
the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Microsoft® Windows® 2000 SP4 (Server edition or Advanced Server

edition)

• Microsoft® Windows Server® 2003 SP1
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Item Requirement

• Microsoft® Windows® XP Professional SP2

media player To support audio attachments, Windows Media® Player Version 9 or later

web browser Microsoft® Internet Explorer® with the following settings:

• Java® or JavaScript® turned on

• language preferences configured to display encoded web pages

System requirements: BlackBerry Manager
The following system requirements apply when installing the BlackBerry® Manager on a computer separate from the
BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Microsoft® Windows® 2000 SP4 (Server edition, Advanced Server edition,

or Professional edition)

• Microsoft® Windows Server® 2003 SP1

• Microsoft® Windows® XP Professional SP2

• Microsoft® Windows® Small Business Server 2003 (Standard edition or

Premium edition)

messaging server system tools Any of the following messaging server system tools:

• Microsoft® Exchange Version 5.5 Administrator

• Microsoft Exchange 2000 System Manager

• Microsoft Exchange 2003 System Manager

• Microsoft Exchange Server MAPI client and CDO 1.2.1

• for Microsoft Exchange 2007, either Microsoft Exchange Server MAPI client

and CDO 1.2.1 or Microsoft Exchange 2003 SP2 System Tools

Microsoft Exchange Organization of

the messaging server system tools

the same Microsoft Exchange Organization as the messaging server

version of the messaging server system

tools

the same version as the messaging server

version of the CDO library the latest version that is supported by the latest version of Microsoft Exchange

in your environment
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Item Requirement

Internet Service Manager To support Microsoft Exchange 2007, the Internet Service Manager component

of Microsoft® Internet Information Services installed

Microsoft® .NET Framework To support languages other than English, localized version of Microsoft .NET

Framework Version 1.1 SP1

web browser Microsoft® Internet Explorer® with the following settings:

• Java® or JavaScript® turned on

• language preferences set to display encoded web pages

data access components Any of the following data access components:

• MDAC Version 2.8 with Security Patch MS04-003 (Version

2000.85.1025.00)

• MDAC Version 2.8 SP2 (Version 2000.86.1830.00)

printer and file sharing To support BlackBerry device implementation, printer and file sharing turned on

USB hub To support BlackBerry device implementation that uses a hub, a USB driver that

supports USB 1.1-compliant hubs

System requirements: BlackBerry MDS Connection Service
The following system requirements apply when installing the BlackBerry® MDS Connection Service on a computer separate
from the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Microsoft® Windows® 2000 SP4 (Server edition, Advanced Server edition,

or Professional edition)

• Microsoft® Windows Server® 2003 SP1

• Microsoft® Windows® XP Professional SP2

• Microsoft® Windows® Small Business Server 2003 (Standard edition or

Premium edition)

messaging server application To support BlackBerry Enterprise Server Version 3.5 and BlackBerry Enterprise

Server Version 3.6, any of the following applications:

• Microsoft® Exchange Version 5.5 Administrator

• Microsoft Exchange 2000 System Manager
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Item Requirement

• Microsoft Exchange 2003 System Manager

• Microsoft Exchange Server MAPI client and CDO 1.2.1

• for Microsoft Exchange 2007, either Microsoft Exchange Server MAPI client

and CDO 1.2.1 or Microsoft Exchange 2003 SP2 System Tools

RSA® Authentication Agent To support enhanced network authentication, RSA Authentication Agent Version

5.0 for Microsoft Windows

System requirements: BlackBerry MDS Integration Service
The following system requirements apply when installing the BlackBerry® MDS Integration Service on a computer separate
from the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Microsoft® Windows® 2000 SP4 (Server edition or Advanced Server

edition)

• Microsoft® Windows Server® 2003 SP1

• Microsoft® Windows® XP Professional SP2

database conditions A database server that is the the host for the BlackBerry Configuration

Database.

System requirements: BlackBerry Router
The following system requirements apply when installing the BlackBerry® Router on a computer separate from the
BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Microsoft® Windows® 2000 SP4 (Server edition or Advanced Server

edition)

• Microsoft® Windows Server® 2003 SP1

• Microsoft® Windows® XP Professional SP2

Installation Guide System requirements: BlackBerry MDS Integration Service
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Item Requirement

firewall A firewall or proxy firewall with the following conditions:

• support for the BlackBerry Router to initiate an outgoing, two-way TCP/IP

connection to an external server on port 3101

• support for the resolution of Internet addresses using DNS

• transparency of the proxy server for proxy firewalls

Supported environments

Item Description

virtual environment The BlackBerry® Enterprise Server and its components support the following

virtual environments:

• VMware® ESX Server Version 2.5.2 or later

• VMware ESX Server Version 3.0.1

Windows® Messenger The BlackBerry Collaboration Service supports Windows® Messenger if MSMQ

Version 3.0 is installed. If installed separately from Microsoft® Windows

Server® 2003, the default Microsoft® Active Directory® Integration and Triggers

subcomponents must be cleared, and only the Common subcomponent must be

selected.

Windows® Messenger with TLS The BlackBerry Collaboration Service supports Windows® Messenger with TLS if

one of the following certificates is installed on the computer that hosts the

BlackBerry Collaboration Service:

• if your instant messaging server is Microsoft® Office Live Communications

Server 2005, an MTLS certificate

• if your instant messaging server is Microsoft Office Live Communications

Server 2005 SP1, a server authentication certificate for the computer

account

IBM® Lotus® Sametime® The BlackBerry Collaboration Service supports IBM Lotus Sametime when you

add the IP address of the computer that hosts the BlackBerry Collaboration

Service to the CommunityConnectivity document on the IBM Lotus Sametime

server.
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Item Description

Novell® GroupWise® Messenger The BlackBerry Collaboration Service supports Novell GroupWise Messenger

when SSL authentication is turned on for the Novell GroupWise Messenger

agents on the computer that hosts the BlackBerry Collaboration Service.

Microsoft® Office Communicator The BlackBerry Collaboration Service supports Microsoft Office Communicator

when MTLS and HTTPS certificates for communication with the Microsoft Office

Live Communications Server are installed on the Microsoft® Office

Communicator Web Access server.

Microsoft Office Communicator with

TLS

The BlackBerry Collaboration Service supports Microsoft Office Communicator

with TLS if one of the following certificates is installed on the computer that hosts

the BlackBerry Collaboration Service:

• if your instant messaging server is Microsoft Office Live Communications

Server 2005, an MTLS certificate

• if your instant messaging server is Microsoft Office Live Communications

Server 2005 SP1, a server authentication certificate for the computer

account

Microsoft Office Communicator and

AJAX Service

The BlackBerry Collaboration Service supports Microsoft Office Communicator

and AJAX Service with the following conditions:

• the following Microsoft hotfixes from www.microsoft.com/support

installed:

• 911996 on your Microsoft Office Live Communications Server

• 915066 on your Microsoft Office Communicator server

• a virtual server installed on your Microsoft Office Communicator server,

with the following conditions:

• all unassigned IP addresses

• forms-based authentication only

• support for an HTTPS browser connection

• an ISAPI filter for the cwaauth.dll file and the ajax.dll file

enhanced network authentication The BlackBerry Enterprise Server and its components support RSA®

Authentication Agent Version 5.0 for Microsoft® Windows®.

SNMP monitoring The BlackBerry Enterprise Server and its components support the SNMP service.

remote access The BlackBerry Enterprise Server and its components support remote access

using any of the following applications:
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Item Description

• Terminal Services for use with Microsoft Windows Server 2000, installed

using Remote Administration mode

• Microsoft Remote Desktop Connection for use with Microsoft Windows

Server 2003

Unsupported environments

Item Description

DMZ The BlackBerry® Enterprise Server and its components, with the exception of the

BlackBerry Router, do not support installation in a DMZ.

messaging server The BlackBerry Enterprise Server and its components do not support the

installation of the messaging server on the same computer.

email application The BlackBerry Enterprise Server and its components do not support the

installation of email applications on the same computer.

Microsoft® SQL Server™ 2005 Express

database

The BlackBerry MDS Integration Service databases do not support the

Microsoft SQL Server 2005 Express database.
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Configuring a Microsoft Exchange 5.5, Microsoft
Exchange 2000, or Microsoft Exchange 2003 messaging
environment

3

Create a Microsoft Windows account and mailbox
You must create and configure a Microsoft® Windows® account and mailbox in the Microsoft® Active Directory® service for
the BlackBerry® Enterprise Server and the BlackBerry Manager so that they can authenticate to the Microsoft Exchange
messaging server.

You might not be able to see the Microsoft Windows account to verify that it has been created.

For more information about the Send As permission and the BlackBerry Enterprise Server, visit www.blackberry.com to read
KB04707.

For more information about how to assign the Send As permission for multiple user accounts, visit
www.support.microsoft.com to read article 912918.

1. On any computer within the Microsoft Windows domain, on the taskbar, click Start > Programs > Microsoft Exchange
> Active Directory Users and Computers.

2. Create an account with the following attributes:
• Name: BESAdmin
• User location: create a Microsoft Exchange mailbox
• Group membership: Domain User

3. Assign this account the Send As permission for all user accounts in the User container of the Active Directory domain.

4. Send a test message to activate the new mailbox.

Configure permissions for the Microsoft Windows account
On each computer that you want to install the BlackBerry® Enterprise Server components on, you must configure the
permissions of the Microsoft® Windows® account that you plan to use to install the BlackBerry Enterprise Server components.

1. On the taskbar, click Start > Programs > Administrative Tools > Local Security Policy.

2. Configure the following permissions for the Microsoft Windows account:
• log on locally with local permissions (if not assigned by default)
• log on as a service

3. On the taskbar, click Start > Programs > Administrative Tools > Computer Management.

4. Add the Microsoft Windows account to the local administrators group.

Installation Guide Configuring a Microsoft Exchange 5.5, Microsoft Exchange 2000, or Microsoft Exchange 2003 messaging
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Configuring Microsoft Exchange permissions for the Microsoft Windows account

Configure Microsoft Exchange Version 5.5 permissions for the Microsoft Windows account

On each computer that you plan to install the BlackBerry® Enterprise Server or the BlackBerry Manager on, you must configure
the Microsoft® Exchange permissions of the Microsoft® Windows® account that you plan to use to complete the installation.

Without the proper permissions, the BlackBerry Enterprise Server cannot function.

> Using Microsoft Exchange Version 5.5 Administrator, in both the Site and Configuration containers, add the Service
Account Admin permission to the Microsoft Windows account.

Configure Microsoft Exchange 2000 or 2003 permissions for the Microsoft Windows account
On each computer that you plan to install the BlackBerry® Enterprise Server or the BlackBerry Manager on, you must configure
the Microsoft® Exchange permissions of the Microsoft® Windows® account that you plan to use to complete the installation.

Without the proper permissions, the BlackBerry Enterprise Server cannot function.

1. Using Microsoft Exchange 2000 or 2003 System Manager, configure the Exchange View Only Administrator permission
with the minimum access level of Administrative Groups.

2. At the server level, configure the following permissions:
• Send As
• Receive As
• Administer Information Store

Identify and resolve any Microsoft Exchange known issues for wireless calendar
synchronization
You must read the Microsoft® Exchange known issues that might impact your messaging environment and install the hotfixes
for them. If your messaging environment includes multiple messaging servers, resolve the known issues that apply to the
latest version of the Microsoft Exchange software in your environment.

Without the proper fixes installed, the BlackBerry® Enterprise Server cannot function.

1. To determine which of the following Microsoft articles apply to your environment, visit www.support.microsoft.com:

Microsoft Exchange tool Microsoft article

Microsoft Exchange Version 5.5 Administrator • 312273

• 818709
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Microsoft Exchange tool Microsoft article

Microsoft Exchange 2000 System Manager • 314606

• 824960

Microsoft Exchange 2003 System Manager • 823343

• 894470

2. Verify that your environment meets the requirements described in the applicable known issues.

3. Download and install the hotfixes for the known issues on the computers on which you plan to install the BlackBerry
Enterprise Server and the BlackBerry Manager.
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Configuring a Microsoft Exchange 2007 messaging
environment

4

Create a Microsoft Exchange 2007 account and mailbox

Before you begin: You must configure Microsoft® Exchange 2007 to support earlier versions of Microsoft® Outlook® by
creating the public folder database. For more information about supporting earlier versions of Microsoft Outlook, visit
www.microsoft.com/support to read article 555851 and visit technet.microsoft.com to read articles 123694 and 124270.

1. Log in to the Microsoft Exchange computer as an administrator with the permission to create an account.

2. Open the Microsoft Exchange Management Console.

3. Create a new Microsoft Exchange account named BESAdmin.

Configure Microsoft Windows permissions for the Microsoft Exchange 2007
account
On each computer that you plan to install the BlackBerry® Enterprise Server or the BlackBerry Manager on, you must configure
the Local Security Policy permissions for the Microsoft® Exchange account that you plan to use to complete the installation.

Without the proper permissions, the BlackBerry Enterprise Server cannot function.

1. Right-click My Computer.

2. Click Manage.

3. In the left pane, expand Local Users and Groups.

4. Navigate to the Groups folder.

5. In the right pane, double-click Administrators.

6. Click Add.

7. In the Enter the object names to select field, type BESAdmin.

8. Click OK.

9. Click Apply.

10. Click OK.

Configure Microsoft Exchange 2007 permissions for the Microsoft Exchange
account

1. On a computer that hosts the Microsoft® Exchange Management Shell, open the Microsoft Exchange Management
Shell.
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2. Perform one of the following actions:
• If you are performing the command locally on the Microsoft Exchange 2007 server, type: add-

exchangeadministrator "BESAdmin" –role ViewOnlyAdmin
• If you are performing the command from another computer, type: get-mailboxserver

"<messaging_server_name>" | add-exchangeadministrator "BESAdmin" –role ViewOnlyAdmin

3. Type the following command: get-mailboxserver "<messaging_server_name> " | add-adpermission –user
"BESAdmin" –accessrights ExtendedRight –extendedrights Send-As, Receive-As, ms-Exch-Store-Admin

Enable BlackBerry device users to send messages in a Microsoft Exchange 2007
environment

1. On any computer within your domain, on the taskbar, click Start > Administrative Tools > Active Directory Users
and Computers.

2. In the View menu, click Advanced Features.

3. Right-click the domain root.

4. Click Properties.

5. On the Security tab, click Advanced.

6. Click Add.

7. Type BESAdmin.

8. Click Check Name.

9. Click OK.

10. In the Apply Onto drop-down list, click User Objects.

11. In the Allow column, select the Send As check box.

12. Click Apply.

13. Click OK.
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Setting up the database connection 5
The BlackBerry® Enterprise Server can connect to the BlackBerry Configuration Database on the Microsoft® SQL Server™
using Microsoft® Windows® authentication or database authentication. If you use Microsoft Windows authentication, the
BlackBerry Manager logs in to the BlackBerry Configuration Database using the Microsoft Windows account that you used
to complete the installation.

If you use database authentication with Microsoft SQL Server, the BlackBerry Manager authenticates to the database using
the database credentials that the administrator provides.

Specifying permissions when connecting to the BlackBerry Configuration
Database using Microsoft Windows authentication

During the BlackBerry® Enterprise Server installation process, if you choose to connect to the BlackBerry Configuration
Database using Microsoft® Windows® authentication, the Microsoft Windows account that you use must have permissions
on the database server. The type of permissions depends on the BlackBerry Enterprise Server setup option that you choose,
and on whether you create the BlackBerry Configuration Database on the same computer as the BlackBerry Enterprise
Server or on another database server.

Specifying MSDE 2000 permissions for the Microsoft Windows account

If you install MSDE 2000 during the BlackBerry® Enterprise Server installation process, you do not need to specify additional
permissions. When you select Microsoft® Windows® authentication during the BlackBerry Enterprise Server installation
process, the setup application automatically assigns the required permissions to the Microsoft Windows account that you
are using to complete the installation.

Assign Microsoft SQL Server permissions to the Microsoft Windows account

> Peform one of the following actions:
• If you create the BlackBerry® Configuration Database on the same computer as the BlackBerry® Enterprise

Server, or if you install the BlackBerry MDS Integration Service, assign the system administrator permission to the
Microsoft® Windows® account that you are using to complete the installation.

• If you create the BlackBerry Configuration Database on another computer, assign server administrator and database
creator permissions to the Microsoft Windows account that you are using to complete the installation. If you are
using Microsoft® SQL Server™ 2005, assign the system administrator permission, or each of the following roles:
SQLAgentUserRole, SQLAgentReaderRole, and SQLAgentOperatorRole.
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Configuring authentication to the BlackBerry MDS Integration Service database

If you install the BlackBerry® MDS Integration Service on a Microsoft® SQL Server™, the setup application uses the same
uthentication method and account that you specified for the BlackBerry Configuration Database. The account requires the
same permissions for the BlackBerry MDS Integration Service database as it requires for the BlackBerry Configuration
Database.

Installation Guide Configuring authentication to the BlackBerry MDS Integration Service database

26



Installing the BlackBerry Enterprise Server software 6

Applications installed with the BlackBerry Enterprise Server components

Item Version Components with which this item is installed

J2SE™ Runtime Environment 5.0 update 9 All

JRE™ 1.6 • BlackBerry® MDS Connection Service

• BlackBerry Collaboration Service

Microsoft® XML Parser 4.0 SP2 • BlackBerry Messaging Agent

• BlackBerry Attachment Service

• BlackBerry Manager

• BlackBerry Router

Microsoft® .NET Framework 1.1 or 1.1 SP1 • BlackBerry Messaging Agent

• BlackBerry Manager

• BlackBerry Collaboration Service

MSDE database 2000 BlackBerry® Enterprise Server

Prerequisites: Installing the BlackBerry Enterprise Server

Item Requirement

credentials from the BlackBerry®

Enterprise Server installation media
• CAL key

• SRP identifier

• SRP key

• SRP host

installation credentials from your

environment
• computer name and port number of the instant messaging server (use the

virtual server name and port number where the AJAX Service is installed, if

applicable)

• computer name and port number of the proxy server (optional)

allowed lists for anti-virus and anti-

spam software applications

Add the blackberry.net domain to the allowed lists in the anti-virus and anti-

spam software applications that the messaging server or gateway uses.
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Install the BlackBerry Enterprise Server software
The installation process includes a restart of the computer.

If you use a .pac file to configure the connection to the proxy server, you can specify that file after you complete the installation
process.

1. Log in to the computer using the BESAdmin account that you created.

2. In the BlackBerry® Enterprise Server installation media, double-click setup.exe.

3. Complete the instructions on the screen.

4. When prompted to restart the computer, click Yes.

5. Log in to the computer using the same account that you used in Step 1 to start the setup application.

6. Complete the instructions on the screen.

After you finish: Complete the following actions:
• If you installed the BlackBerry Collaboration Service, download the BlackBerry Instant Messaging Connector from www.

blackberry.com/support/downloads and install it.
• If you installed MSDE 2000, update the sa account password. For more information, visit www.support.microsoft.com

to read article 32233.
• If you configured the BlackBerry Configuration Database on a Microsoft® SQL Server™ during installation, ensure the

BlackBerry Configuration Database collation setting is set to default case-insensitive.

Test the BlackBerry Enterprise Server installation

1. In the Microsoft® Windows® Services, verify that the BlackBerry® Enterprise Server services are running.

2. In the Microsoft Windows Event Viewer and in the log files that are located in  <drive>:Program Files\Research In Motion
\Blackberry Enterprise Server\Logs, check for error messages.

For troubleshooting information, visit www.blackberry.com/support.

3. In the BlackBerry Manager, add a test user account.

If you added a test user successfully, the connection from the BlackBerry Enterprise Server to the BlackBerry
Configuration Database and the messaging server is open.

4. If you installed the BlackBerry MDS Connection Service, browse to http://<BES_host>:8080.

If the status page appears, the BlackBerry MDS Connection Service is running successfully.
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Install the BlackBerry database notification system
The BlackBerry® database notification system helps to reduce the number of database queries that the BlackBerry®
Enterprise Server makes to the BlackBerry Configuration Database.

If you create the BlackBerry Configuration Database on the same computer as the BlackBerry Enterprise Server, the
BlackBerry database notification system installs automatically.

If you create the BlackBerry Configuration Database on a database server that is installed on a separate computer, you can
install the BlackBerry database notification system manually after you complete the BlackBerry Enterprise Server installation.

Before you begin: You must have the system administrator role on the database server.

1. On the database server, open the BlackBerry Enterprise Server installation media.

2. In the Tools\DBNS folder, copy RimEsp.dll to C:\Program Files\Microsoft SQL Server\MSSQL\Binn.

3. Open the Microsoft® SQL Query Analyzer.

4. Using the console, navigate to Database\DBInstallScripts\SQLServer\4.1 on the BlackBerry Enterprise Server
installation media.

5. Open NotifyInstall.sql and change <_DATABASENAME_> to the name of your BlackBerry Configuration Database.
For example, BesMgmt.

6. Run the script.

7. Confirm that the Microsoft SQL Query Analyzer displays the message “Function dbo.xp_RIMxxxx registered.”

8. To set up additional BlackBerry Configuration Database instances in your environment, repeat steps 1 through 7.
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Post-installation tasks 7

Configure support for Unicode text in calendars on BlackBerry devices in a
Microsoft Exchange 2003 environment

Before you begin: You must have installed the hotfixes for wireless calendar synchronization for Microsoft® Exchange 2003.

1. On the BlackBerry® Enterprise Server, open the Registry Editor.

2. In the left pane, navigate to HKEY_LOCAL_MACHINE\software\Research In Motion\BlackBerry Enterprise Server
\Agents.

3. Create a DWORD value named SetLocaleIDs.

4. Set the value to 1.

5. In the Microsoft® Windows® Services, restart the BlackBerry Messaging Agent.

Connecting to a BlackBerry Attachment Service

Complete the following tasks if you have installed the BlackBerry® Attachment Service on a computer separate from the
BlackBerry® Enterprise Server. These tasks ensure that other BlackBerry Enterprise Server components can connect to the
BlackBerry Attachment Service.

Connect the BlackBerry MDS Connection Service to a BlackBerry Attachment Service
Complete the following task if you have not installed the BlackBerry® Attachment Service on the same computer as the
BlackBerry MDS Connection Service.

1. On the computer that hosts the BlackBerry MDS Connection Service, navigate to C:\Program Files\Research In Motion
\BlackBerry Enterprise Server\MDS\Servers\Instance\config.

2. In a text editor, open rimpublic.property.

3. Type the following lines at the end of the file:

Attachment.Server.host=<attachment_server_hostname>

Attachment.Server.port.asp=1900

Attachment.Server.port.rqp=2000

4. Save and close the file.

5. In the Microsoft® Windows® Services, restart the BlackBerry MDS Connection Service.

6. To connect another BlackBerry MDS Connection Service to the BlackBerry Attachment Service, complete steps 1 through
5.

7. On the computer that hosts the BlackBerry Attachment Service, open the Registry Editor.
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8. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BBAttachServer\BBAttachBESExtension.

9. Change AllowRemoteServices to 1.

10. In the Microsoft Windows Services, restart the BlackBerry Attachment Service.

Connect the BlackBerry Messaging Agent to a BlackBerry Attachment Service
Complete the following task if you have not installed the BlackBerry® Attachment Service on the same computer as the
BlackBerry® Enterprise Server.

1. On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Programs > BlackBerry
Enterprise Server > BlackBerry Server Configuration.

2. On the Attachment Server tab, in the Configuration Option drop-down list, click Connector Configuration.

3. In the Server field, type the name or IP address of the computer that hosts the BlackBerry Attachment Service.

4. In the Server Submit Port field, type the TCP/IP port number (between 1024 and 65,535) that the attachment connector
uses to send the requests for attachment data to the BlackBerry Attachment Service.

5. In the Server Result Port field, type the TCP/IP port number (between 1024 and 65,535) that the BlackBerry Enterprise
Server uses to query and retrieve the converted data from the BlackBerry Attachment Service.

6. In the Polling Time(s) (seconds) field, type the interval (between 10 and 300 seconds) that the BlackBerry Enterprise
Server uses between querying the BlackBerry Attachment Service for when the conversion of large attachments is
complete and the attachment is available for delivery.

7. Click OK.

8. In the Microsoft® Windows® Services, restart the BlackBerry Dispatcher.

Connect a remote BlackBerry Attachment Service to the BlackBerry Messaging Agent
Complete the following task if you have not installed the BlackBerry® Attachment Service on the same computer as the
BlackBerry® Enterprise Server.

Before you begin: Open the BlackBerry Configuration Panel on the BlackBerry Enterprise Server and record the port
information for the Server Submit Port and the Server Result Port that the BlackBerry Enterprise Server uses.

1. On the computer that hosts the BlackBerry Attachment Service, on the taskbar, click Start > Programs > BlackBerry
Enterprise Server > BlackBerry Server Configuration.

2. On the Attachment Server tab, in the Configuration Option drop-down list, click Attachment Server.

3. In the Submit Port field, type the same port number that you typed in the Server Submit Port field on the BlackBerry
Enterprise Server.

4. In the Result Port field, type the same port number that you typed in the Server Result Port field on the BlackBerry
Enterprise Server.

5. In the Configuration Port field, type the TCP/IP port number (between 1024 and 65,535) that the administrative
console should use.
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6. Click OK.

7. In the Microsoft® Windows® Services, restart the BlackBerry Attachment Service.

Authenticating the BlackBerry MDS Integration Service to the BlackBerry
Manager and web services

After you install the BlackBerry® MDS Integration Service, you must install a digital certificate for the BlackBerry MDS
Integration Service in the key store on the same computer. This certificate allows server-authenticated communication
between the BlackBerry MDS Integration Service and the BlackBerry Manager.

You can install a self-signed certificate for the BlackBerry MDS Integration Service, or you can obtain a signed root certificate
from a certificate authority and install it in the key store using the Java® keytool. You can replace the self-signed certificate
with a signed root certificate at any time, but it is recommended that you install the certificate that you want to use
immediately after you install the BlackBerry MDS Integration Service, and before you allow authentication with the
BlackBerry Manager or web services using that certificate.

You can also export the BlackBerry MDS Integration Service certificate to allow client authentication with external web
services.

For more information about using the Java keytool, visit java.sun.com/javase/6/docs/technotes/tools/windows/
keytool.html.

Allow the BlackBerry MDS Integration Service to communicate with the BlackBerry Manager
When the BlackBerry® Manager connects to the BlackBerry MDS Integration Service for the first time after installation, the
BlackBerry Manager prompts you to view and install the BlackBerry MDS Integration Service self-signed certificate. This
certificate allows server-authenticated communication between the BlackBerry MDS Integration Service and the BlackBerry
Manager.

Before you begin: Perform this task immediately after you install the BlackBerry MDS Integration Service.

1. In the BlackBerry Manager, in the left pane, click a BlackBerry MDS Integration Service.

2. In the certificate installation dialog box, click View Certificate.

3. Review the certificate information.

4. Click Install Certificate.

5. Complete the instructions on the screen. Accept the default settings.

6. When prompted, click Cancel.
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Allow client authentication between the BlackBerry MDS Integration Service and web services
The BlackBerry® MDS Integration Service self-signed certificate enables client authentication between the BlackBerry MDS
Integration Service and web services hosts. If the BlackBerry® MDS Runtime Applications in your environment use HTTPS
to communicate with web servers to receive data and updates, export the BlackBerry MDS Integration Service certificate to
the web services hosts. This allows BlackBerry MDS Runtime Applications that use web services to authenticate with and
access web services.

Before you begin:
• Contact your organization's BlackBerry MDS Runtime Application developers for information about the web services

that the BlackBerry MDS Runtime Applications in your environment use.
• If you replaced the BlackBerry MDS Integration Service self-signed certificate with a root certificate from a certificate

authority, web services must trust the root certificate authority to authenticate with the BlackBerry MDS Integration
Service.

1. Using Microsoft® Internet Explorer®, export the BlackBerry MDS Integration Service self-signed certificate from the
trusted root certificate authorities area of the computer's key store.

2. Send the BlackBerry MDS Integration Service self-signed certificate to the web services servers that the BlackBerry
MDS Runtime Applications use.

3. Verify that the certificate is installed in the trusted key store of the web services servers.

After you finish:
• If you have multiple BlackBerry MDS Integration Service servers installed, export the certificate for each BlackBerry

MDS Integration Service.
• Allow BlackBerry MDS Runtime Applications to access web services using HTTPS.

Configuring how users search for email addresses in a Hosted BlackBerry Enterprise
Server environment

If you host a BlackBerry® Enterprise Server and multiple organizations subscribe to your hosted service, you must customize
the address lookup feature so that BlackBerry device users can access their organization’s contact list and download the
information to their BlackBerry devices. By customizing how users search for email addresses, you can restrict the
BlackBerry device users from accessing the contact information of another organization that subscribes to your hosted
service.

You must make sure that the organization name for each user is listed accurately and consistently in the contact list. For
example, if the organization name appears as an acronym in some entries but in full in others, the address lookup results
might be inaccurate. If a user tries to look up contact information for a user whose organization name is not specified, no
address lookup results appear.

When users try to look up contact information, they need to type the entire email address.
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If you do not want to use the address lookup feature, you can configure the BlackBerry Enterprise Server to look up user
addresses using LDAP. With LDAP, users can perform more comprehensive searches for addresses in the GAL. The BlackBerry
Enterprise Server does not search for a user’s organization name in the GAL. Instead, it uses an LDAP field as a filter for
retrieving users with a specific organization name. You can select an existing LDAP field or you can create a custom field.

Configure how users search for email addresses in a Hosted BlackBerry Enterprise Server
environment

1. On the BlackBerry® Enterprise Server, open the Registry Editor.

2. In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server
\Agents.

3. Verify that the DWORD value for AllowAddressLookup is 1.

4. Create a DWORD value named HostedServer.

5. Set the value to 1.

6. In the Microsoft® Windows® Services, restart the BlackBerry Controller.

Configure the Hosted BlackBerry Enterprise Server to search for email addresses using LDAP

1. On the BlackBerry® Enterprise Server, open the Registry Editor.

2. In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server
\Agents.

3. Create a DWORD value named LDAPSearch.

4. Set the value to 1.

5. Create a DWORD value named LDAPALPSearch.

6. Set the value to 1.

7. In the Microsoft® Windows® Services, restart the BlackBerry Controller.

Configure the Hosted BlackBerry Enterprise Server to search for email addresses using a custom
LDAP field

1. On the BlackBerry® Enterprise Server, open the Registry Editor.

2. In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server
\Agents.

3. Create a string value named LDAPCompanyField.

4. Set the value to a string that represents the LDAP field that you want to use as the company name field.

5. In the Microsoft® Windows® Services, restart the BlackBerry Controller.

Installation Guide Configuring how users search for email addresses in a Hosted BlackBerry Enterprise Server environment

35



Add or remove a BlackBerry Enterprise Server component
Complete this task if you want to add or remove a BlackBerry® Enterprise Server component from a computer that also hosts
other BlackBerry Enterprise Server components.
CAUTION:  Before removing the existing BlackBerry Enterprise Server installation, move active user accounts to another
BlackBerry Enterprise Server.

1. Perform one of the following actions to add a component:
• remove the existing installation and reinstall the BlackBerry Enterprise Server with the component
• if supported, install the component on a separate computer

2. Perform one of the following actions to remove a component:
• turn off the service and set its Startup type to Manual
• remove the existing installation and reinstall the BlackBerry Enterprise Server without the component
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Creating and managing administrators 8

Administrative roles

The BlackBerry® Enterprise Server uses predefined roles, which correspond to common administrative roles in organizations,
to control who can perform specific tasks and limit who can access sensitive data in your organization.

You assign each BlackBerry Enterprise Server administrator to an administrative role. If you already manage your organization
using Microsoft® Windows® groups, assign those groups to the administrative roles so that you can manage role membership
through the group.

When an administrator starts the BlackBerry Manager, the BlackBerry Manager checks the authentication credentials,
determines the administrative role, and displays a list of the tasks that the administrator can perform.

Role Description

security administrator (rim_db_admin_security) These administrators can perform all tasks. They are the

only administrators who can manage role membership and

change sensitive security properties, such as licenses and

encryption keys.

The administrator account that you created during the

installation process is assigned the security administrator

role automatically.

enterprise administrator (rim_db_admin_enterprise) These administrators can perform all tasks that relate to

user accounts, services, instances of the BlackBerry

Enterprise Server, and global application data.

These administrators cannot view role membership,

licenses, or encryption keys.

device administrator (rim_db_admin_handheld) These administrators can perform all tasks that relate to

user accounts and BlackBerry device management,

including:

• supporting new user accounts

• implementing BlackBerry devices

• managing software configurations

• managing the installation and behavior of third-party

applications on BlackBerry devices
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Role Description

senior help desk administrator

(rim_db_admin_sr_helpdesk)

These administrators can perform all tasks that relate to

user account management, including:

• adding, moving, and deleting user accounts

• updating and sending IT policies to BlackBerry devices

• sending IT administration commands to BlackBerry

devices

junior help desk administrator

(rim_db_admin_jr_helpdesk)

These administrators can perform tasks that relate to user

account management, including:

• creating and sending passwords for activating

BlackBerry devices over the wireless network

• resending service books or IT policies

These administrators cannot add, move, or delete user

accounts or send certain IT administration commands.

auditor (rim_db_admin_audit_<role>) These administrators can view all tasks and properties that

relate to their role, but they cannot perform the tasks or

change the properties. Use this view-only role when

training new administrators.

Creating a BlackBerry Enterprise Server administrator in a Microsoft SQL Server
environment

BlackBerry® Enterprise Server administrators are database users who can access the BlackBerry Configuration Database
using the BlackBerry Manager. This access is restricted to the administrative roles that the BlackBerry Enterprise Server
administrators are assigned to.

Only administrators who are assigned to the security administrator role can create other BlackBerry Enterprise Server
administrators accounts. When creating administrator accounts, perform one of the following tasks:
• assign a BlackBerry administrative role to an existing database account
• create a new database account and assign it an administrative role
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Assign an administrative role to a new or existing Microsoft SQL Server database account
Note:  Do not assign an administrative role using the Microsoft® SQL Server™ consoles or assign more than one administrative
role to an administrator. The BlackBerry® Configuration Database uses the most restrictive settings to determine which
tasks the BlackBerry Manager displays, so an administrator who is assigned both enterprise and junior help desk roles sees
only the tasks for the junior help desk role.

Before you begin:
• Verify that you have the system administrator role on the database server.
• If you are assigning an administrator to the security or enterprise administrative role, verify that the administrator has

administrative permission on the Microsoft® Exchange messaging server.
• If you are creating a new database account and and want to use Microsoft® Windows® authentication, verify that the

Microsoft Windows user or group account already exists.

1. In the BlackBerry Manager, in the left pane, click BlackBerry Domain.

2. On the Role Administration tab, click a role.

3. Complete one of the following actions:
• To add an administrative role to an existing Microsoft SQL Server database account, click List Administrators.
• To create a new Microsoft SQL Server database account and assign it to an administrative role, click Add

Administrators.

4. Complete one of the following actions:
• To add an administrative role to an existing administrator account, click the administrator account that you want to

add the role to.
• To create a database account only and add an administrative role to the account, type a user name.
• To create a database account for an existing Microsoft Windows user or group and add an administrative role to the

account, type a user name preceded by a domain name (for example, DOMAIN\username).

5. If prompted, type and confirm a password.

6. Click OK.

Configure the BlackBerry Manager to use database authentication in a Microsoft
SQL Server environment
During the installation process, if you choose to connect to the BlackBerry® Configuration Database using Microsoft®
Windows® authentication, the BlackBerry Manager uses Microsoft Windows authentication automatically. If you create
database accounts for your administrators, you must change the type of authentication that the BlackBerry Manager uses.

1. In the BlackBerry Manager, on the Tools menu, click Options.

2. Click Database.

3. In the Authentication drop-down list, click Database Authentication.
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4. Click OK.

5. Restart the BlackBerry Manager.

Assign a BlackBerry Enterprise Server administrator to a different administrative
role
As organizational changes occur, you might need to move an administrator to a different administrative role.

1. In the BlackBerry® Manager, in the left pane, click BlackBerry Domain.

2. On the Role Administration tab, click the role that the administrator is assigned to.

3. Click List Administrators.

4. Remove the administrator from the list.

5. Click the role that you want to assign the administrator to.

6. Click the administrator.

7. Click OK.

The database permissions change immediately.

After you finish: Instruct the administrator to restart the BlackBerry Manager.

Delete an administrator from a BlackBerry Enterprise Server

1. In the BlackBerry® Manager, in the left pane, click BlackBerry Domain.

2. On the Role Administration tab, click the role that the administrator is assigned to.

3. Click Remove Administrators.

4. In the drop-down list, click the administrator.

5. Click OK.

After you finish: Optionally, you can delete the database account associated with that administrator from the database.
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Removing the BlackBerry Enterprise Server software 9

Remove the BlackBerry Enterprise Server software
Use this task to remove the BlackBerry® Enterprise Server or a BlackBerry Enterprise Server component that you have
installed on a separate computer.

1. On the taskbar, click Start > Settings > Control Panel > Add/Remove Programs.

2. Click BlackBerry Enterprise Server.

3. Click Remove.

4. Click Yes.

After you finish: Optionally, you can delete remaining log files and remove the JRE™ software and the Java® Web Start
software from the computer.

Delete registry entries from your computer

1. On the computer that you removed the BlackBerry® Enterprise Server software from, open the Registry Editor.

2. Delete the following registry keys:

Location KEY

HKEY_LOCAL_MACHINE\SOFTWARE Research In Motion

HKEY_LOCAL_MACHINE\System\CurrentControlSet

\Services

BBAttachServer and any keys starting with “BES” or

“BlackBerry”

HKEY_LOCAL_MACHINE\System\ControlSet001

\Services

BBAttachServer and any keys starting with “BES” or

“BlackBerry”

HKEY_LOCAL_MACHINE\System\ControlSet00n

\Services

BBAttachServer and any keys starting with “BES” or

“BlackBerry”

HKEY_CURRENT_USER\Software Research In Motion

HKEY_CURRENT_USER\Software\Microsoft\Windows

NT\ CurrentVersion\Windows Messaging SubSystem

\Profiles

any keys named BlackBerryServer, BlackBerry Manager,

or listed as the name of your BlackBerry Enterprise Server

HKEY_USERS\.DEFAULT\Software Research In Motion

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft

\Windows\CurrentVersion\App Paths

BESManmmc.dll
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Location KEY

HKEY_CLASSES_ROOT\Installer\Products any key in which the ProductName is BlackBerry

Enterprise Server

Removing the BlackBerry database notification system

You must remove the BlackBerry® database notification system manually if you installed it manually. You can choose to
remove the BlackBerry database notification system for one or all instances of the BlackBerry Configuration Database.

Remove the BlackBerry database notification system from one BlackBerry Configuration
Database

1. Open the Microsoft® SQL Query Analyzer.

2. Using the console, navigate to  <drive>:\Database\DBInstallScripts\SQLServer\4.1 in the BlackBerry® Enterprise
Server installation media.

3. Open NotifyUnInstall.sql.

4. Delete all commands after --- delete notification stored procedures and -- delete notification tables.

5. Run the script.

6. Perform one of the following actions:
• Restart the Microsoft® SQL Server™.
• In Windows® Explorer, navigate to C:\Program Files\Microsoft SQL Server\MSSQL\Binn. Rename RimEsp.dll (for

example, to RimEspXXX.tmp) .

Remove the BlackBerry database notification system from all BlackBerry Configuration
Database instances

1. Open the Microsoft® SQL Query Analyzer.

2. Using the console, navigate to  <drive>:\Database\DBInstallScripts\SQLServer\4.1 in the BlackBerry® Enterprise
Server installation media.

3. Open NotifyUnInstall.sql.

4. Run the script.

5. Using Windows® Explorer, navigate to C:\Program Files\Microsoft SQL Server\MSSQL\Binn.

6. Delete RimEsp.dll.
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Troubleshooting the BlackBerry Enterprise Server
installation process

10

A third-party tool did not install successfully and the BlackBerry Enterprise
Server setup application closed
Possible solution

1. In the BlackBerry® Enterprise Server installation media, open the Tools folder.

2. Double-click the setup application file for the tool that you want to install.

3. Complete the instructions on the screen.

4. Restart the BlackBerry Enterprise Server setup application.

Failed to write License Key to the Database
This message appears when you try to add the CAL key.

Possible solution

After you restart the computer during the BlackBerry® Enterprise Server installation process, you must log in using the same
Microsoft® Windows® account that you used to start the installation process.

1. Close the setup application.

2. Log out of the computer.

3. Log in to the computer.

4. Restart the setup application.

Previous version detected but no database available
This message appears when you start the setup application and the setup application stops responding.

Possible solution

The registry keys that identify your BlackBerry® Configuration Database must exist in the Microsoft® Windows® Registry.

1. On the computer on which you plan to upgrade the BlackBerry® Enterprise Server, open the Registry Editor.

2. In the left pane, navigate to HKEY_LOCAL_MACHINE\Research In Motion\BlackBerry Enterprise Server\Database.

3. Create the following case-sensitive string values (if they do not exist):
• DatabaseName: Type the name of the BlackBerry Configuration Database.
• DatabaseServerMachineName: Type the computer name of the database server.
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4. Restart the setup application.

The BlackBerry Collaboration Service does not connect to Microsoft Office Live
Communications Server 2005
Possible solution

If your instant messaging environment supports Windows® Messenger with TLS, you must configure authentication.

1. Download the trial edition of Microsoft® Office Communicator 2005 from www.microsoft.com/downloads.

2. Install Microsoft Office Communicator 2005 on the computer that hosts the BlackBerry® Collaboration Service.

3. Connect to Microsoft® Office Live Communications Server 2005 using Microsoft Office Communicator 2005.

4. If a connection does not open, verify that you installed or imported the certificates required for authentication.

The setup application did not prompt you to change or confirm the MAPI profile
Possible solution

Create and change the MAPI profile manually.

1. In the BlackBerry® Enterprise Server installation media, open the Tools folder.

2. Double-click Fixmapisvc.exe.

3. Verify that mapisvc.inf is installed at C:\winnt\system32\ or C:\windows\system32\.

4. On the taskbar, click Start > BlackBerry Enterprise Server > Edit MAPI Profile.

5. Type the Microsoft® Exchange server name.

6. Click the Microsoft® Windows® account that is associated with the MAPI profile.

7. Click OK.

The setup application prompts you for access to the installation media for
Microsoft .NET Framework Version 1.1
When the BlackBerry® Enterprise Server setup application installs Microsoft® .NET Framework Version 1.1 SP1 on a computer
that hosts a previously installed version of Microsoft .NET Framework Version 1.1, it prompts you for access to the installation
media for Microsoft .NET Framework Version 1.1.

Possible solution

You can access the netfx.msi file that is included with the BlackBerry Enterprise Server installation media.

1. In the BlackBerry Enterprise Server installation media, open the Tools folder.
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2. Double-click netfx.msi.

3. Complete the instructions on the screen.
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Glossary 11
AJAX

Asynchronous JavaScript® and XML

BlackBerry Domain
A BlackBerry Domain consists of the BlackBerry Configuration Database with its users and any BlackBerry Enterprise
Server instances that connect to it.

BlackBerry MDS
BlackBerry® Mobile Data System

CAL
A client access license (CAL) limits how many users you can add to the BlackBerry® Enterprise Server.

CDO
Collaboration Data Object

DMZ
A demilitarized zone (DMZ) is a neutral subnetwork outside of an organization's firewall. It exists between the trusted
LAN of the organization and the untrusted external wireless network and public Internet.

DNS
Domain Name System

GAL
Global Address List

HTTPS
Hypertext Transfer Protocol over Secure Sockets Layer

ISAPI
Internet Server Application Programming Interface

J2SE
Java® 2 Platform, Standard Edition

JRE
Java® Runtime Environment

LAN
local area network
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LDAP
Lightweight Directory Access Protocol

MAPI
Messaging Application Programming Interface

MDAC
Microsoft® Data Access Components

messaging server
A messaging server sends and processes messages and provides collaboration services, such as updating and
communicating calendar and address book information.

MMC
Microsoft® Management Console

MSDE
Microsoft® SQL Server™ Desktop Engine

MSMQ
Microsoft® Message Queuing

MTLS
Mutual Transport Layer Security

SNMP
Simple Network Management Protocol

SQL
Structured Query Language

SRP
Server Routing Protocol

SSL
Secure Sockets Layer

TLS
Transport Layer Security

XML
Extensible Markup Language
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Legal notice 12
©2008 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, SureType® and related
trademarks, names, and logos are the property of Research In Motion Limited and are registered and/or used as trademarks
in the U.S., Canada, and countries around the world.

IBM, Lotus, and Sametime are trademarks of International Business Machines Corporation.  Microsoft, Active Directory,
Internet Explorer, Outlook, SQL Server, Windows, Windows Media, and Windows Server are trademarks of Microsoft
Corporation.  Novell and GroupWise are trademarks of Novell, Inc.  RSA is a trademark of RSA Security. Java, JavaScript,
JRE, and are trademarks of Sun Microsystems, Inc. VMware is a trademark of VMware, Inc. All other brands, product names,
company names, trademarks, and service marks are the properties of their respective owners.

The BlackBerry smartphone and other devices and/or associated software are protected by copyright, international treaties,
and various patents, including one or more of the following U.S. patents: 6,278,442; 6,271,605; 6,219,694; 6,075,470;
6,073,318; D445,428; D433,460; D416,256. Other patents are registered or pending in the U.S. and in various countries
around the world. Visit www.rim.com/patents for a list of RIM (as hereinafter defined) patents.

This documentation including all documentation incorporated by reference herein such as documentation provided or made
available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without condition,
endorsement, guarantee, representation, or warranty of any kind by Research In Motion Limited and its affiliated companies
("RIM") and RIM assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or omissions in this
documentation. In order to protect RIM proprietary and confidential information and/or trade secrets, this documentation
may describe some aspects of RIM technology in generalized terms. RIM reserves the right to periodically change information
that is contained in this documentation; however, RIM makes no commitment to provide any such changes, updates,
enhancements, or other additions to this documentation to you in a timely manner or at all.

This document might contain references to third-party sources of information, hardware or software, products or services
and/or third-party web sites (collectively the "Third-Party Information"). RIM does not control, and is not responsible for,
any Third-Party Information, including, without limitation the content, accuracy, copyright compliance, compatibility,
performance, trustworthiness, legality, decency, links, or any other aspect of Third-Party Information. The inclusion of Third-
Party Information in this document does not imply endorsement by RIM of the Third-Party Information or the third party in
any way. Installation and use of Third-Party Information with RIM's products and services may require one or more patent,
trademark, or copyright licenses in order to avoid infringement of the intellectual property rights of others. Any dealings
with Third-Party Information, including, without limitation, compliance with applicable licenses and terms and conditions,
are solely between you and the third party. You are solely responsible for determining whether such third-party licenses are
required and are responsible for acquiring any such licenses relating to Third-Party Information. To the extent that such
intellectual property licenses may be required, RIM expressly recommends that you do not install or use Third-Party
Information until all such applicable licenses have been acquired by you or on your behalf. Your use of Third-Party Information
shall be governed by and subject to you agreeing to the terms of the Third-Party Information licenses. Any Third-Party
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Information that is provided with RIM's products and services is provided "as is". RIM makes no representation, warranty or
guarantee whatsoever in relation to the Third-Party Information and RIM assumes no liability whatsoever in relation to the
Third-Party Information even if RIM has been advised of the possibility of such damages or can anticipate such damages.

This documentation might contain references to third-party sources of information, hardware or software, products or services
including components and content such as content protected by copyright and/or third-party web sites (collectively the
"Third Party Products and Services"). RIM does not control, and is not responsible for, any Third Party Products and Services
including, without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness,
legality, decency, links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party
Products and Services in this documentation does not imply endorsement by RIM of the Third Party Products and Services
or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS,
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR
WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE
QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A
COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE
OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR
PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND
CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE
DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY
LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS
THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE LIABLE
FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-
PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT,
CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES
FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS
OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO
TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH
RIM PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF RIM PRODUCTS OR SERVICES OR ANY PORTION
THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES,
COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES WERE FORESEEN OR
UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER
OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY
LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE
CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT,
NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH
OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED
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HEREIN; AND (B) TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS
(INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE
PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE,
AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM HAVE ANY LIABILITY
ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your
airtime service provider has agreed to support all of their features. Installation or use of Third Party Products and Services
with RIM's products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid
infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party Products
and Services and if any third party licenses are required to do so. If required you are responsible for acquiring them. You
should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any Third Party
Products and Services that are provided with RIM's products and services are provided as a convenience to you and are
provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties of any
kind by RIM and RIM assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and Services shall
be governed by and subject to you agreeing to the terms of separate licenses and other agreements applicable thereto with
third parties, except to the extent expressly covered by a license or other agreement with RIM.

The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM applicable
thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR
WARRANTIES PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER THAN THIS
DOCUMENTATION.

Certain features outlined in this documentation require a minimum version of BlackBerry® Enterprise Server Software,
BlackBerry® Desktop Software, and/or BlackBerry® Device Software and may require additional development or Third Party
Products and Services for access to corporate applications.

This product includes software developed by the Apache Software Foundation (www.apache.org/) and/or licensed pursuant
to Apache License, Version 2.0 (www.apache.org/licenses/). For more information, see the NOTICE.txt file included with the
software. Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on
an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for
the specific language governing permissions and limitations under the License.

Research In Motion Limited
295 Phillip Street
Waterloo, ON N2L 3W8
Canada

Research In Motion UK Limited
200 Bath Road
Slough, Berkshire SL1 3XE
United Kingdom

Published in Canada
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